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Detailed assignment editing

Introduction

Many Microsoft Project users are rightfully wary of resource optimisation;
levelling is often seen as a ‘dark art’ and clumsy editing of assignments can
adversely affect the project’s schedule. Once assignment editing is
understood, however, it is a useful technique to model in greater detail how
people will work against tasks and can often result in more realistic project
schedules.

These tips and tricks illustrate the techniques available; from simple task
splitting to timephased editing and the creation of assignment contours.

Background

By default, Microsoft Project schedules assignments automatically, based upon
the scheduling formula. This creates a simple ‘flat’ assignment, with assigned
units being at a constant rate throughout the duration of the assignment. As
work in reality is usually performed at a variable rate (a change in assigned
units over time), the default ‘flat’ contours can be overridden by manually
editing assignment information
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Detailed assignment editing

Splitting a task

Often, when parallel assignments exist, one task has an inherently higher
priority than another:

Tazk &
Taszk B
Tazk <

Lowver priarity task

Resource A

2 Resource A

& = Resource A Wik Shi Bhi 8Bhi 8hi Bh 16k i16h:16hi1Bh:16h
Task B Wiark

Bhi &hi Bhi 6hi gh
Lower priority task | njork Bhi Bhish 8hiah Bhi Bh! Bhi Bhi Sh

e There is a resource conflict for Resource A in week 2 (parallel
assignments on Task B and the Lower priority task).

Although resource leveling using the leveling parameter 'Leveling can create
splits in remaining work' could resolve the situation, it is sometimes better to
apply a split manually to provide greater user control:

a. Click on Split Task .

b. Position the cursor at the point within the task's bar when the split
will commence:

Task Name ‘04| Feb 2, '04 [Feh 9, '04 [Feb 16, '04 Feh 23, '04 Mar 1, '04
| Splt Task: =TT EEMTPIF EEMTIMTFEE
start: Rebiogt tesource A

Click the mouse ko insert a split on the task.

4 Laowver priotity task Resource A

c. Drag the split until the resume date, then release.

l Task Mame 'D4| Feb 2 '04 | Feb 9, '04 | Feb 16, '04 Feb 23, '04 Mar 1, '04 |
SEMTPTFEEMTMTF EEMTMTF EEMTMTFEEMTMTERE]

| Critical Task:

Skark: Feb 16 '04

Finish: Feb 27 '04

. 4 Laowver priotity task

d. Changing the task's schedule to:

Task Name '04] Feb 2, '04 [Feh 8, '04 [Feb 16, '04 Feb 23, '04 Mar 1,'04
SEMTITFEEMTMTFEEMT MTF EEMTATF EEMTIMTFEE
1 Task &
2 Task B
3 Task C
4 Lawver priority task Resource A
Task: Lower prioricy task,
Start: Feb & '04
Finish: Feb 16 '04
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Detailed assignment editing

Manually-created splits can also be removed:

a. Position the cursor to the later part of the split:

Task Mame '04] Feb 2, '04 [Feb 8,'04 [Feb 16, '04 Feh 23, '04 Mar 1, '04
F ST F BEMT P BT F ST T BEpTTE
| Critical Task:
Skart: Feb 16 '04
Finish: Feb 27 '04
L 4 Lowwver priority task

b. Drag the split to the left to join up with the pre-split part of the task,
then release.

ST EEMTP T F BB ST FEEMTTEEE

F Tazk Mame '04] Feb 2, '04 [Feb 8,'04 [Feb 16, '04 Feh 23, '04 Mar 1, '04

Critical Task:

Start: Feb 7 '04
Finish: Feb 15 '04
4 Loweer priority task 5

c. Removing the split:

Tazk &
Task B
Task C

Resource A

Lowver priority task

@ e  Task splitting creates contoured assignments.
k= e Tasks can have several splits applied to them:
I Lower priority tazk
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Detailed assignment editing

Manual assignment delays

When one resource is assigned to a task, the assigned work will commence at
the task's scheduled start date. If several resources are assigned, the task's
scheduled start will be the date the earliest assignment can start and the task's
scheduled finish will be when the last assigned work is finished. Normally, all
resources will start at the same time and finish at the same time (if the
resource's assigned work and shift patterns are the same). Assignments can
be edited to change when they start, relative to the task's scheduled start.

Take the example below:

=| Task with 2 assignments 120hrs | ek 16h:16h 16hi16h 1ER 8hi 8hi 8hi ghi 8k
Resaurce 1 30 s | ipinrk Bhi 8h! &hi 8hi &h Bhi 8h! &hi Bhi &h
Resource 2 40 brs | york 8hi Bhi 8hi 8hi 8h

e Resource 1 has 80 hours of assigned work that will take 10 days to
complete.
e Resource 2 has 40 hours of work that will be completed within 5 days.

To edit the assignment for Resource 2 to delay the start of the assignment
until the beginning of the second week:

a. To choose a suitable view, select Task Usage from the View menu.

b. Select the assignment to change, then EI (for the Assignment
Information dialog):

2 | Taszk with 2 assignments
Resolres 1

R

c. Edit the assignment start date and confirm with OK.

Assignment Information g|
General l Tracking l Motes l
|Task with 2 assignments
Resource: |Resource 1
Work: 40h = Units: 0% =
‘Wark contour: |Flat j
Start: qw =
Fiiish: |Feb 13704 -]
0,00 Cost rate table: A -
Cancel |
{ ( = Project Learning International Limited
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Detailed assignment editing

d. Changing the schedule of the assigned work:

=1 Task with 2 assignments 120hre | ek 8hi 8hi Bhi 8hi gh 16hi1Bhi16hI16h: 16h
Resowrce | 80 hrs | njork @hi &hi Bhi oh! Bh Bhi 8hi @hi Bh! 8h
Resource 2 00 iork “Thi Ohi Ohi Oh! Ohi &hi 8hi 8hi 8hi 8h

e Any manually entered assignment delays can not be cleared by the Clear Leveling command

(within the Resource Leveling dialog).
e  Assignment delays can be viewed and edited within a task form view (from Window..Split).

Marne: |Task with 2 assignments Durakion: [10d ::l IV Effort driven

(2}
—
-:E: E Start: |Feb 2 '04 j Finish: |Feb 13 '04 j Task bype: |Fixed Units | % Complete: 0% :jl
[w]
i ID | Resource Mame Work R/ |Leveling Delay | Delay Start: Finish -
il | 1 iResourced 80k odi  od: Feb 2 ‘04 Feb 13'Md
2 iResourcez “40h _ sd> Feb 904! Feb 13'04
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Detailed assignment editing

Contoured assignments defined

By default, all assignments within a project have a 'Flat' contour. A flat
contour takes the assigned work and distributes it evenly over the duration of
a task:

Five day task 3 days Bh

Bhi h
Flat (no contour) 8h :

8hi ®h

A number of other pre-defined contour types are available:
Contour Type

Distribution of 40 hours of work

Back loaded
Five day task B33days |0a7hi147hi  3h.  dhiseTh! © ipami gl ehizeTh
Back loaded 0E7hi14Thi  3hi  4hiSEThi ig3shi Bhi  Bhi2ETh

Front loaded

Five day task 8.33 days Bhi Bhi 7hi Bhid33n 367hi173hi  1hiD.27h
Frant Ioaced ghi &hi  Fhi  BRid433K IEThI173R 1hi0Z27h
Double peak

Five day task 10 days 2h 4h 3h 4h 2h 2h 1h 8h 4h 2h

Double peak Zh 4h 8h 4h 2h 2h 4h gh 4h 2h
Early peak

Five day task 10 days 2hi ahi 8hi Bh! Bh dhi dhi 2hi 120 08h

Early peak Jhi 4hi B Bhi  Bh dhi 4hi Zhi 1.2hi 08k
Late peak

Five day task 10davs | gghi 1.2hi 2hi dhi gk Bhi B8hi @hi 4hi 2Zh

Late peak 08hi 12k 2hi 4kl 4k Bhi Bhi Bh 4hi  2h

Bell
Five day task 10days | gshi 18k 32h Bani sk © sni B4ni 32n 16 Oshi
Bell 0ghi 16k 32h Bahi 8kt { Bhi B4h 32hi 16hi 0B8R
Turtle
Five day task VA4days  257hi515n 7720 Bhi o Gh 5.43h! 2.85hi 0.28h
Turtle 257hiS15hiT772hi  Bhi  gh 5.43hi 2.85hi 0.28h

¢ With most contours, a fixed units or fixed work task will increase its
duration almost twofold as compared to a flat contour.
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Detailed assignment editing

This distribution can also be displayed in a graph:

O = b L st O D
P T R R W
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*  Flat
Back loaded
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Double pesk
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Hints

To review which assignments have contours, add a column to a table including the 'Work contour

field.

To filter on contoured assignments, create a global filter with the filter criteria: "Work Contour <>

Flat".

With a fixed duration task, the duration will stay constant, and the assigned work will reduce:

Five day fixed durstion
Bell

20 hrs
20 hes

1.2h

4.8h

Sh

4.8h

1.2h

1.2h

4.5h

dh

4.8h

12h

(Ih?q

4 \
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Detailed assignment editing

Editing contoured assighments

Assignments can quickly be changed from a flat profile to a predefined
contour. If Sally Beaumont will be spending most of her efforts at the end of a
task within the 'Manual' project, it can be changed from Flat to Back loaded:

a. To choose a suitable view, select Task Usage from the View menu.

b. Select the assignment to change, then El (for the Assignment
Information dialog):

Tim Brown

¢. Change the work contour and assigned units from:

Assignment Information E|
; i l Tracking l Motes l
|Create conkents & index
|Sa||y Eieaumonkt
Wark: 30h il Units: (] 75% 3-
—_—
Wark contour: ( |Flat Y j
Start: [Mar 1504 -
Einish: |Mar 1904 j
1,500.00 Cost rate table: a -
OF | Cancel |
d. To:

Assignment Information E

l Tracking l Maotes

|Create conkents & index

|Sa||y Beaurmonk

waork: 74h :| Units: (Jroow =)

‘Wark contour: @ j
Start: |Mar 15 '04 j
Fiiish: |par 19704 -]
’W Cost rate table: m

K | Cancel |

e. Confirm with OK.
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Detailed assignment editing

f. Changing the schedule of the assigned work:

e | Task Mame Wiark

) Mar 15, 04
Detals 495 16 [ 17 [18 [18
= Create conterts & incex S4hrE |k Thi Shi11hi13hi14h
ulll Sally Bealraont 24 hvs | iiork 1hi 3hi Shi Thi 8h
Tim Brown 30hes ek Bhi Bhi Bhi Bhi Bh

o Sally's assigned work progressively increases each day until the
final day of the assignment is at the assigned units value.

o As the Create contents and index task is a fixed duration type, its

duration has remained at 5 days. As such, Sally's assigned work
has reduced to 24 hours.

-g To remove a contour, edit the assignment and change the work contour to Flat.
T Contour types can be reviewed on a resource-by-resource basis using the Resource Usage view.
{ ( = Project Learning International Limited
¥ L PO Box 41-143, Lower Hutt 5047, New Zealand
PT@]'E@L"EB.FH Iu&nﬁﬁ . . . www.projectlearning.net
=y - info@projectlearning.net

www.projectlearning.co.nz




Detailed assignment editing

Editing timephased work

In addition to predefined contours, timephased work can be directly edited.
Exact work values can be manually entered against assignments; hour-by-hour,
day-by-day or week-by-week. For example, to make Tim Brown work 4 hours
per day on the task 'Create contents & index' within the 'Manual' project:

a. To choose a suitable view, select Task Usage from the View menu.
b. Enter the assigned hours value for the first day of the assignment:

O | TaskMame ork Jostals - N s T e [ 3
=I Create cortents & index adhrs | ek Thi 9Ki11hi 13hi14h
ulll Sally Beaumont 24 hws | yiark 1hi 3k Shi Thi 8h
Tin Brown 308 work 48 Bh Bk Bh Bh
=] Manual completed Ohrs | yyork :

c. Using the fill handle, drag the hours from the first timephased cell
onto successive cells, then release.

@ | TaskNams otk |ostabs | e S T [ [®
-l Create contents & index a2hrs | gk Shi Shi11hi13hi14h
ulll Sally Beaumont 24 hws | yiark 1hi 3k Shi Thi 8h
lﬁl Tirn Brown 28BS york dhi Bhi Bh: Bh: BhY
| Manual completed Ohrs | yyork

d. Changing the assignment:

@ TaskName ek | petais | 1 Y5 118 | 7 [T (18 0
=| Create contents & index ddhrs | igrk ohi Thi Shil1hii12h
‘nﬂ Sally Beaurmaont 24 hrs | iork
lﬁl Tim Brown 20 hrs | jork
& | Manual completed Ohrs | york i

Manually edited contours have the indicator: lﬁl
To remove a manual contour, edit the assignment and change the work contour to Flat. Note the
work and units values as these will be calculated by Microsoft Project.
e When editinmesed work, check on the minor scale (bottom tier) units of the displayed
e}

Hints

timescale (
accuracy.

e 'Hours' are the default unit for work values, set from the Schedule tab of the Options dialog box
(Tools..Options)..

, as this relates to each cell entry. A daily scale will provide the most
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Detailed assignment editing

Leveling edited assignments

When assignments have been edited, their schedule will invariably be altered
as well. It is therefore prudent to apply resource leveling to the project. By
default, leveling will firstly clear any leveling delays thus taking tasks back to
their earliest start dates. Leveling will then be able to create an optimum
schedule for resource assignments from their earliest dates forwards. This

can be illustrated on a project that has been leveled, but now has resource
conflicts:

a. From the Tools menu, select Level Resources.

b. Retain the default dialog box settings as ringed below.
X

Resource Leveling

Leveling calculations

" Aukomatic %+ Manual

Lock for gverallocations on a | Day by Day ¥ | basis
v Clear leveling walues before leveling

Leveling range For ‘Manual Project’

% Level entire project

" Level  From: |Feb2'04 J
Toi  [Mar 2304 =]

Resolving overallocations

Leveling arder: |Standard j
¥ Level only within available slack

¥ Leveling can adjust individual assignments on a task
¥ Leveling can create splits in remaining work

Help Level Mow
| |

Cancel

c. Click Lewvel Maw
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Detailed assignment editing

d. Changing the Leveling Gantt view from:

esdhens LE\;Eing 1Feb { Feh {Feb {Feb I Mar {Mar § Mar {Mar IMar  Apr § 2pr {Apr { 2pr It
M= e L I I U UL
= Manual Project 0 edays ¥ v
+ Weekly meetings 0 edays ,
= Content 0 edays W v
Design structure 0 edays 50%]
Write body texdt 0 edays
Set page layouts 0 edays own
-| Exercises 0 edays
Creste exercises 0 edays ] Iy Beaumont
Test exercizes 0 edays er
Creste conterts & index| 2 edays Tim B rowr-[ﬁll"!-k;l,ﬁally Beaumont
Manual completed 0 edays & 323
e. To:
PSS LE\:a":g JFeb JFeb {Feb {Feb I Mar | nar § Mar {Mar Inar T apr § 2pr {Apr | 2pr It
T
= Manual Project 0 edays ! v
+ Weekly meetings 0 edays ,
-] Content 0 edays
Design structure 0 edays [60%]
Wite: body test
=et page layouts 0 edays own
=| Exercises 0 edays !
Create exercises 0 edays ly B it
Test exercizes 0 edays er
Create contents & index| 0 edlays] Tim Brown[50%],Sally Beaurnont
Marual completed Oedays | & 323

o The leveling delay applied to Create contents & index has been
removed as Tim could now commence work as soon as he has
available working time (in this case his resource calendar
provides working time Monday through Saturday).

o Write body text now has a leveling delay of 2 elapsed days. In
this case, this is because Tim has an availability profile that
states he is unavailable until February 9, 2004 (the beginning of
the second week of the project).

® Every time a project's schedule is changed, check for resource conflicts, as they could have been

*g inadvertently introduced.
T e The Leveling Gantt view displays preleveled bars (in green), to compare to the current schedule
(in blue).
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